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1 Introduction 

1.1 Overview 

The Web-server II operation and installation manual is a generic document for both 
FT1020G3 and FT128 panels.  Hence, from hereon, where ever the term “Panel” is used, 
it is referred to either the FT1020G3 or FT128. 
 
The Web-server II (1598) is a communications device where remote monitoring, interface 
to nurse call system, control1 and maintenance are necessary for the control panel. The 
functions of the Web-server II is dependent on which software is downloaded as well as 
which configuration data is created and downloaded. 
 
The software (EBLWeb) and configuration data are downloaded to the Web-server II via a 
commissioning tool, EBLWin (a PC program). The EBLWin is dependent on the Firetracker 
system and the EBL software version. 
 
In previous versions, a separate software Configuration Tool (WebG3 or Web128) was 
required. In this current version, the Web-server configuration is done within EBLWin 
V2.1.x for both FT1020G3 and FT128. 
 
For this to work, the Real-Time-Operating-System (RTOS) on the Web-server has to be 
upgraded to RTOS Revision 1.512 or higher3. 
 
The configuration described in this manual has been tested with both Windows XP and 
Windows 7 OS. 
 
This document describes the following software:  

EBLWeb V2.1.x4 for Web-server II 1598 (Hardware ver 1.1). 

To create the configuration data, the EBLWin V2.1.0 or later configuration software must 
be used. It is also used to download both the configuration data (SSD-Site Specific 
Data) and the software for the Web-server II (1598). 

 
The Web-server II is used in a FT1020G3 system with up to six units5 in a TLON Network 
or in standalone FT128 / FT1020G3.  It is to be connected to Internet / an intranet (LAN), 
to a Security Management system and/or as a Gateway. 
 

NOTE: The first two digits of the software version for EBLWin and EBLWeb (e.g. 
version 2.1.x) must be matched. 

1.2 Definitions / Explanations 

Definitions / explanations / abbreviations / etc. frequently used or not explained elsewhere 
in the document. 
 
 

                                                             

1 Although the Web-server II is capable of controlling the panel remotely, this is prohibited in some state regulations.  Please 

check with your state regulations if this is permissible. 
2
 Download from: http://www.beck-ipc.com/en/download/licence.asp?id=sc1x3_rtos_151&l=1 

3
 Upgrade the RTOS is required only for the older stock, new stock of 1598 will be loaded with the latest RTOS software. 

4 On the date of printing this manual the EBLWeb software revision is V2.1.0 

5 Only one Web-server is allowed to be installed in a FT1020G3. 

http://www.beck-ipc.com/en/download/licence.asp?id=sc1x3_rtos_151&l=1
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Abbreviation Description 

C.I.E. 
Control and indicating equipment (=control unit; C.U.) 
 

C.U. Control unit (=Control and indicating equipment) 

S/W Software 

H/W Hardware 

Circular log / list 
The log / list re-starts when it is "full". The first events will 
be overwritten, i.e. a circular log / list shows the xx latest 
events. 

Straight log / list 
The log / list stops when it is full and has to be erased 
before the logging can start again, i.e. a straight log shows 
the xx earliest events. 

LAN Local Area Network 

SSD Site Specific Data 
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2 General Description 

The Web-server II (1598) can be used with one or more of the following functions: 
 

1. As a Web-server for presentation of the actual FT1020G3 / FT128 status in a 
PC using the web browser Microsoft Internet Explorer or Chrome, via 
Internet or intranet (LAN).  See page 28. 

2. As a Web-server also for remote operation of an FT1020G3 / FT128 via 
encrypted and safe two-way communication (HTTPS).  See Section 6.1.4.4 
page 49. 

3. As an e-mail client to send e-mails in case of special events (e.g. fire alarm, 
fault, etc.), see page 37 section 4.7.2 on E-mail Address.  To set up, see section 
3.2 step 22). 

4. As a Gateway to a separate system, i.e. to transmit and present fire alarm 
information in another (PC) system.  See section 3.2 step 21) 

5. To connect the Firetracker system to a Security Management system via 
EBLnet (TCP/IP),  

 
The Web-server II has to be configured and the EBLWeb software has to be downloaded 
via EBLWin 2.1.x.  Figure 1 gives an example of how a networked FT1020G3 provides 
remote monitoring using the Web-server.  In the case of the FT128, replace the FT1020G3 
blocks with a single FT128 Panel. 

 

Figure 1  PC is connected to an FT1020G3 system via Internet / an intranet (LAN) and 
the Web-server II. 

 

2.1 Web-server II, 1598 

 
The Web-server II consists of a light grey plastic enclosure, which is vertically mounted on 
a DIN rail.6 
 
   
 
 
 
 
 
 
 

                                                             

6
  A symmetric 35 mm DIN rail is fitted inside the panel when the Web-server is requested to be installed in FT1020G3 or FT128 

FT1020

G3 CIE 

FT1020

G3 CIE 

FT1020G3 System 
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Figure 2 Web-server II, 1598 with connectors 

 
The Web-server II has four interfaces as shown in Figure 2: 
 

1. Power Connector (+24Vdc) 
2. RS232 D-Range 9-pin (for Gateway function) 
3. RS232 Connector (serial line for Web-Server) 
4. RJ-45 Ethernet Connector (for LAN connection) 

 
For connections and technical data, see Connection Diagram Section 9 Page 60. 
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3 Quick Start 

3.1 Software Installation Required 

 EBLWin 2.1.x 
 @CHIPTOOL (Chiptool_Install_V6.1.3.6.exe) can be downloaded from 

http://www.beck-ipc.com/en/download/licence.asp?id=chiptool_install&l=1 
 EBLtalk terminal.exe7 (if Gateway function is used). 

3.2 Walk-Thru Guide 

 
1) Connect to respective Panel as shown in connection diagram Figure 4 page 60. 

 
2) Connect between “MODEM COM. (RS232C)” port on the Web-server and 

computer/device if Gateway function is used. 
 

3) Connection between laptop and the 1598 WEB-SERVER II with a CAT-5 LAN 
cable via the Ethernet RJ-45 COM port.   
 

4) Obtain network parameters: 
On Windows Start menu, click windows sympol  +R then type “cmd” without 
quotes followed by enter key. 
 

5) Type “ipconfig” at the command prompt 8 then enter: 

 
 

6) Copy the IP Address, Subnet Mask, and Default gateway.  All 3 must be made 
available. 

Note:  

You may need to ask your systems administrator for available and/or allowed IP 
addresses.  The IP address for the Web-server will be derived from this. 

For this walk-thru guide, the next available IP Address9 would be 10.1.1.3 

 

                                                             

7
 The software EBLtalk terminal.exe can be obtained from your nearest BROOKS office. The software is available in Brooks 

server Z:\Technical Services\Products (under construction)\Analogue Addressable Systems\Webserver\Web Server 
Setup\Chiptool_Install_V6.1.3.6 

8 The ipconfig at the command prompt is shown for Windows 7, it might be slightly different for Windows 8 

9
 IP addresses starting with 192.168.x.x are private IP addresses and should not be used.  192.168.1.169 is the IP address set 

at delivery.   

http://www.beck-ipc.com/en/download/licence.asp?id=chiptool_install&l=1
file://server01/Data/Technical%20Services/Products%20(under%20construction)/Analogue%20Addressable%20Systems/Webserver/Web%20Server%20Setup/Chiptool_Install_V6.1.3.6
file://server01/Data/Technical%20Services/Products%20(under%20construction)/Analogue%20Addressable%20Systems/Webserver/Web%20Server%20Setup/Chiptool_Install_V6.1.3.6
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Follow steps 7-10 if you have to set IP addresses manually.  
7) In Windows: Go to Control Panel>Network and Sharing Centre and click on 

Local Area Connection: 

 

 
 

8) When the Local Area Connection Status dialog box opens, click on Properties: 
 

 
 

9) In the Network tab under the “This connection uses the following items:” choose 
Internet Protocol Version 4 (TCP/IPv4) then click on Properties: 
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10) Click on the radial button for “Use the following IP address:” and type in the 
addresses (Note: the addresses here are for this example only).  You should 
check with your systems administrator for these IP addresses): 

 

Important: 

If you are using your personal computer that is normally connected to the internet to 
perform this one-off configuration, REMEMBER to return to this dialog window and 

return the settings to “Obtain an IP address automatically”. 

 
11) Run @CHIPTOOL to scan for the Web-server. It should show up with this 

window:  
 

 
 

Note:  

The IP Address, Subnet Mask, and Default gateway shown are reserved addresses at 
delivery.  These have to be reconfigured.  All Web-Servers should be upgraded with 
RTOS v1.7.  See Section 3.3.1.1 for upgrading. 
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12) Right click on the selection and choose “IP Configuration” in the context menu, 
will bring up this dialog box: 

 

 
 

Note: Serial number or MAC-ID number will be different on yours, do not change this! 

Change ONLY settings for IP Address, Network Mask, and Gateway given by your 
Systems Administrator. 

The IP address assigned for this example only is 10.1.1.3, Network mask 255.255.0.0, 
and Gateway 10.1.1.2.  These will be different from yours.   

Then set these accordingly: 
 

a. Leave the interface box blank and  
b. Check the box “Config default Ethernet interface” and 

c. Click on the  button (This will start the configuration and you 
should see “Configuration successful” at the bottom of the dialog box 
when completed. 

 
13) Check the main window on @CHIPTOOL, you should observe that the IP 

address, Netmask, and Gateway settings have changed according to your 
settings: 

 

 
 

 
 



Operation & Installation Manual  
      MA440 Rev 1.0 

 

 

15 of 62 
 

14) Right click on the selected Web-server (here named “BaseInit”) then choose 
FTP from the context menu. 
 

 
 

This will then open up with the connection dialog box: 
 

 
 

Ensure that the Target IP address is correctly selected as you have assigned in 
step 12. 

Note:  

You can change the User and Password but if you forget, you will have to re-flash the 
Web-server and start all over.  See Section 3.3 page 25 on How to Format Web-
server 1598 for Making A Clean Install. 

 
For a brand new Web-server II and for this walk-thru example: 
 
User:  ftp 
Password: ftp 
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15) Once connected you should see “Connected to <your Target IP address>”.  In 
this case, it is 10.1.1.3. 
 

 
 
Alternatively,  

Ping the IP address 10.1.1.3 to see if connection is fine.  Go to “Command 

Prompt” and “ping 10.1.1.3” type this at the prompt without quotes: 

 
 

If all is good, you should see “Reply from 10.1.1.3:” with (0% loss). 

16) Upgrade the RTOS to RTOS Version 1.7110 if required. Refer to How to Format 
Web-server 1598 for Making A Clean Install or Upgrade see Section 3.3, page 
25. 

 
17) Using the @CHIPTool, check that the RTOS version has been upgraded. 

 
18) Launch EBLWin and “Add Web Server…” (Right click on Control unit). 

 

                                                             

10 Download from: http://www.beck-ipc.com/en/download/load.asp?f=/rtos/archiv/SC1x3V0170Release.zip 

http://www.beck-ipc.com/en/download/load.asp?f=/rtos/archiv/SC1x3V0170Release.zip
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19) From the menu, System>User Data… enable the WEB-server access for 
“Service personnel” then click OK. 

 
20) Double click on the Web-server just added to the Control Unit and it should 

display the Web-server unit configuration dialog box.  Fill out the area circled: 
 

 
 

The Hardware ID is the five characters that are printed on the Web-server plastic 
enclosure as shown. 
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21) Click on the “Gateway/EBLnet settings” tab: 
 

 
 

Choose “EBLTalk” for Gateway type only if using EBLTalk (use settings as 
shown).  EBLnet settings “Use EBL net” must be selected and a port number 
assigned when using remote management system e.g. Skywalker. 

 
The following is applicable Only if email notification is required (Optional steps): 

 
22) This step and the next are optional. Perform only if email notification is required:   

Click on the “Notification settings” tab. 
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23) Fill in the Sender address, in this example webG3@brooks.com.au was 
assigned. You must enter the SMTP address in dotted decimal format 11. The 
default SMTP port is 25, this may vary. Check with your Systems 

Administrator then click on the  button under the E-mail section. 

24) Fill out the persons to send this notification to, then click the compose button. 
Address to the person(s) you want to notify under certain panel conditions e.g. 
Fire, Fault, Disablement, Service, Pre warning, Test mode, etc. and email will 
be sent to the receiver’s email address.   
 
Enter the subject just like in any email.  In the body are commands that you 
can use e.g. Date, event type etc.  Click on any of these and the command will 
appear in the Body automatically showing when the event has occurred. 

 
25) Gateway / EBLnet settings are optional. 

If, Gateway function is not used select “None” Under the “Gateway / EBLnet 
settings” tab: 

 

 

 

 

 

 

 

                                                             

11
 Tip: If you only have the SMTP address in pain text format, try going to the windows command prompt and pinging it, 

example: ping panasonic.com. This will convert your plain text format into dotted decimal format. 

mailto:webG3@brooks.com.au


Operation & Installation Manual  
      MA440 Rev 1.0 

 

 

20 of 62 
 

If Gateway function is used:  set 12 the EBL Talk 13 as follows then click OK: 

 

26) Under the Browser settings tab, Click on Browse to add the file location of 
your company logo ( if required). 

 

.  

27) If required, change the ftp access under “Unit settings” tab: 

                                                             

12
 These settings are only applicable when used with EBLtalk terminal.exe provided by BROOKS.  EBLtalk terminal.exe is an 

RS232 Terminal interface to check data communications.   BROOKS cannot support any other open source programs since 
their settings may vary.  If you choose to use other open source programs, you must find the settings that work yourself.  

13
 EBL Talk can be used together with SkyWalker and while the Web-server Home page is running. 
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Click on the  button and fill in the new user name and password.  
Default user name and password is ftp. 

Warning: If you forget your username and password, you will not be able to download 
the Web-server configuration.  In this case, performing a clean install as described in 
Section 3.3, might be necessary to return everything to default settings.  Then repeat 
this procedure from the beginning of this section. 

 
28) On configuration completion, check that you have your dongle (5094) on your 

laptop/PC plugged into a USB port.  Connect between laptop/PC and CIE via 
USB (Type A to Type B) cables and be logged on from Tools>Log on Control 
Unit. 

 

29) Download the EBLWeb V2.1.0 (file EBLWeb210_ENGLISH.BIN) only if 
upgrading versions or suspect corruption.  See Section 7.1.1. 

 

30) Right click on the Web-server and choose “Download EBL Web configuration” 
from the context menu: 
 

 

 

 

 

  
 

 

Then click the Download button with the “Include SSD Data” ticked 

in the Download EBL Web configuration Tab window.   
 

 

 

 

 

 

 

 

 



Operation & Installation Manual  
      MA440 Rev 1.0 

 

 

22 of 62 
 

31) The progress bar will fill at the bottom of the page then this message will pop-
up (It is recommended to wait 30 seconds, click OK, then restart the 
webserver manually.): 

 

 

 

 

 

 

32) Right click again on Web-server then 
choose “Download SSD…” The 
download should begin within 30 
seconds.  

33) On completion, you should see the 
message “Download completed 
successfully.” Before you close the 
Download SSD window. 

 

 

34) After download completes, reset the Web-server by disconnecting the power 
connector to it and reconnecting. 

 
35) Reconnect to an active Ethernet LAN cable connection to the Web-server’s RJ-

45 Ethernet COM port. 
 

36) Open an Internet Browser on a remote computer that is connected to the 
internet and type the IP address that was assigned in step 20). 
 

 

 

Note:  

Sometimes the Download SSD window gives the message “Downloading…” but does 

nothing and the Download button becomes active again. 

 
If this happens, just click the Download button again.  A successful download should 

show the message “Download completed successfully…” with the progress bar filled. 



Operation & Installation Manual  
      MA440 Rev 1.0 

 

 

23 of 62 
 

… you should then see this page: 

37) Type in the Username and Password.  Both are case sensitive.  (Web-server 
access is only given if set in step 19). 

 
38) To test, activate an MCP with the test key on the fire panel.  You should see the 

icon  flashing: 
 

 
 

39) To check what has been activated, click on next to the alarm to bring up 
the next screen: 

  
 

40) Go to the MCP and pull out the test key. 

41) On the remote computer, click the Reset button  and hit apply.  The Alarm 
should clear and the fire panel should return to normal conditions. 
 

42) Connect the RS232 cable from laptop to Web-server via port labelled “MODEM 
COM. (RS232C)”. 

 

43) To test the Gateway function (if set up in step 25), run EBLTalk Terminal: 
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On the menu, Settings>RS232 Settings, change the Baud Rate to 9600 and 
ensure the other settings are as shown, then click OK: 
 

 
44) When you activate an MCP on the panel, you should see a message 14 in the 

EBLTalk Terminal window that an alarm has been set off: 
 

 
 

Note: if the text message was not configured for the MCP on the FT1020G3 or FT128, 
you will only see the line <SOH>…00401..ending with <US> without the circled text. 

                                                             

14
 This message will only appear here provided you have configured texts for your Panel via the EBLWin Config Tool.  
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3.3 How to Format Web-server 1598 for Making A Clean Install 
or Upgrade 

In cases where download of a new configuration fails, incomplete or corrupted which may 
cause rebooting or lose communications with the C.I.E., formatting of the Web-server might 
be required. 
 
This section describes how to format the Web-server (if necessary) using @CHIPTOOL. 
Normally @CHIPTOOL will be able to detect the Web-server when connected to the same 
network. 
 
The following are required: 
 
1. Formatting File: format_sc1x3.hex 

Download from: 
http://www.beck-ipc.com/en/download/licence.asp?id=format_sc1x3&l=1 
 

2. Upgrade the RTOS, file required: SC1x3V0151_FULL.hex (or higher version) 
Download from: 
http://www.beck-
ipc.com/en/download/load.asp?f=/rtos/archiv/SC1x3V0170Release.zip 
 

3. Software: @CHIPTOOL (Chiptool_Install_V6.1.3.6.exe) 
Download from: 
http://www.beck-ipc.com/en/download/licence.asp?id=chiptool_install&l=1 

 

3.3.1 Connections for Formatting via RJ-45 COM port 

1) Refer to the connection diagrams on page 60 for 
Panel specific connections. 

2) Connect between the laptop and the 1598 via a 
CAT-5 LAN cable Ethernet RJ-45 COM port. 

 
 
 

3.3.1.1 Walk-Thru: Formatting/Upgrading the Web-server (Program Flash Image 

Method) 

Note: If this method fails, use the method described in section 3.3.2. 

 
1) Launch the @CHIPTOOL software.  Right click on the selected Web-server and 

choose Program flash image from the context menu. 
Note that the target type should be SC143. 

 

 
 

2) Specify the location of the file named format_sc1x3.hex (if formatting) where 
it was downloaded to.  Do not change any other settings. (Repeat this 
procedure and use SC1x3V0170_FULL.hex to upgrade). 

http://www.beck-ipc.com/en/download/licence.asp?id=format_sc1x3&l=1
http://www.beck-ipc.com/en/download/load.asp?f=/rtos/archiv/SC1x3V0170Release.zip
http://www.beck-ipc.com/en/download/load.asp?f=/rtos/archiv/SC1x3V0170Release.zip
http://www.beck-ipc.com/en/download/licence.asp?id=chiptool_install&l=1
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Then click on the START button under the section “Use UDP/IP”. 

 

Note:  

In the area “Use UDP/IP”, the last 5 characters in “Serial number or MAC-ID” must 
match the one the Web-server’s plastic enclosure as in Step 20).  The “IP address of 
IPC@CHIP” may not match in the case of a corrupt Web-server.  In this case, it is 
better to use the procedure in Section 3.3.2 & 3.3.2.1. 
 

 
3) Once successfully completed, you will see this: 

 
If you notice in the log reading, “Reconfiguration device failed”, it is alright to 
ignore it.  In any case after downloading, you should see the “Transfer 
completed” dialog box. Click OK to complete. 

 
4) Now Web-server is ready for reconfiguration.  Note that by default the name is 

SC143.   Follow steps 11)-15) under Section 3.2 page 11 to reconfigure with a 
new IP address. 
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3.3.2 Connections for formatting/upgrading via PLC COM. RS232C 
port 

1) Refer to the connection diagrams on page 60 for panel 
specific connection. 
 
 

2) Connect between the laptop and the 1598 using the 
serial cable provided with the special 3 pin connector 
at the end plugged into the Web-server’s port named 
“PLC COM (RS232C)”. 
 
 

3) Connections on the special 3 pin connector at the 
end of the serial cable. Colour coding on the serial 
cable may differ.  There will be a tag on the serial 
cable showing the connections to GND (Red or 
Brown), TXD (Orange or Black), RXD (Yellow or 
White).  The single digit represents the pin-out on 
the 9-pin D-range connector. 

 
 

3.3.2.1 Walk-Thru: Formatting the Web-server (Serial Gang Program Flash Image 

Method) 

Note: If the CHIPTOOL is unable to detect the IP address from the Web-server or 
unable to Program Flash Image, format the Webserver described in this section.  Then 
repeat the procedures described in Section 3.3.1.1 to Program Flash Image. 

  
1) Launch the @CHIPTOOL. 

 
2) From the menu choose Flash>Serial Gang Program.  Select the correct COM port 

and the file to flash. 
 
Use format_sc1x3.hex to format and SC1x3V0170_FULL.hex to upgrade. 
 

3) Click on the Start button.  In the message box next to COM1 it should begin with the 
message “Contacting” and it should complete with “Transfer completed”.  (It should 
take no more than 30 seconds – if more, it has probably crashed.  In this case, shut 
down all programs15, power down the Web-server and start again.) 

                                                             

15 @CHIPTOOL simply minimises and runs in Windows if the  button was used and will continue to run in the background.  

Either use File>Exit @CHIPTOOL from the menu or right-click on the @CHIPTOOL icon on the Windows taskbar notifications 

area and choose Exit @CHIPTOOL to completely shutdown the program. 
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4 Functions 

The following chapters describes all EBLWeb functions.  
The start page in the browser might look as follows (before login): 
 

 

NOTE!  The look might vary depending on screen resolution, settings, etc. 

 
There is no support for anonymous login. For any user to login, they should have at least 

the lowest priority level even if the Web-server is to be used for status information only.   

For remote operations and access to corresponding information, a username and a 

password are always required for at least user level 2 (Building Officer). 

Any access to the Web-server has to be configured via EBLWin 2.1.x, and it uses the 

same usernames and passwords as configured for the EBL-system16. 

User level 1 (Information Only) 

User level 2 (Building Officer) 

User level 3 (Service Personnel) 

4.1 User Login 

Username:  Type the User name for the User level respectively. 
Password:  Type the Password for the User level respectively. 
 
Both Username and Password are case sensitive. 
 

Click the  button to open with the Status – Summary page. 

                                                             

16
 In EBLWin 2.1.1, from the menu: System> User data… 
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Depending on User’s access level, some features, buttons may be greyed out, access to 

remote operations disabled and some information hidden. 

The information is continuously updated approximately every 10 seconds. 

In case of inconsistencies between EBLWeb and FT1020G3, perform a synchronisation on 

the Panel via menu H8/S7 or EBLWin V2.1.x.  After restarting the Web-server, 

synchronization is done automatically. 

4.2 User Logout 

To logout the current session in EBLWeb, click the logout button     in the upper-right 

corner. 

4.3 Silence PC buzzer (sound off) 

When a fire alarm is activated, the buzzer/speaker in the PC is used for sound alert. 

Click the Silence PC buzzer button  to silence the buzzer/speaker in the PC (until a 

new fire alarm is activated).  
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4.4 Status 

After login or in any other view click home/status button  to see the status summary 

view.  

 

EBLWeb will present the current status of the FT-system, i.e. showing current alarms, 

faults, disablement and other deviations corresponding to the Firetracker CU. The status 

will be shown on different web-pages and also indicated by the top row of icons. The icons 

will either blink or be constantly lit.  

Note: The colour in the icon is not visible until the respective event is activated. 

The summary consists of two areas. 
 

The Firetracker CU Status Area 

Fire alarm  

Pre-warning/Co-incidence/Quiet/Delayed 

alarm 

 

Fault  

Disablement  

Technical warning  

Interlocking  

Door open N/A 

Zones in test mode N/A 

Service signal N/A 

Output activation N/A 
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The Web Status Area 

WEB function disablement  

Communication error  

 

Each of the different summary items in the list will be described in the following pages. 

The list page for each status can be opened through the List button . Every list can show 

a certain amount of items per page, and to see the total amount of pages that the list 

consists of, and to navigate amongst the pages, there are page handling buttons. 

4.4.1 Fire Alarm 

In case of a fire alarm, click on the fire alarm icon  or List button  to view the fire 

alarm list. 

The Time (date and time), Zone, Address and Text (alarm text) are displayed. 

Type = Smoke, Heat, Multi, MCP, Extinguishing system or other. 

State = Heavy smoke/heat, Test, Isolated and Alert Annunciation alarm acknowledged / 

not acknowledged.  

Link1 = A hyperlink to open a web-camera, document, a drawing etc. for more information 

regarding the alarm point. 

Link2 = A hyperlink to open a web-camera, document, a drawing etc. for more information 

regarding the alarm point. 

Click Reset button in the reset column for a pop-up dialog for reset of alarm. (Requires 

login on User level 2 or 3.) 

The pop-up dialog for alarm reset have options to either reset the current alarm or reset 

all alarms in the fire alarm list. 

4.4.2 Pre-warning/Co-incidence/Quiet/Delayed Alarm 

 
In case of pre-warning, co-incidence alarm, quiet alarm, or delayed alarm, click on the pre-

warning/ Co-incidence/Quiet/Delayed alarm icon  or List button  to view the 

corresponding alarm list. This list is separated into tab pages for respective pre-warning 

and alarm type. 

 

The list is similar to the fire alarm list. See Fire Alarm section 4.4.1. 
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4.4.3 Fault 

In case of faults, click on the fault icon  or List button  to view the fault list. 

The Time (date & time), Tech.No, Zone/Address (when applicable), Fault description 

(fault message) are displayed.  State (Serviced / Acknowledged / "Blank" = Neither 

Serviced nor Acknowledged). 

Text = More info, such as alarm text if the fault is related to a detector etc. Place the pointer 

above the information icon. 

Link1 and Link2 = A hyperlink to open a web-camera, document, a drawing etc. for more 

information regarding the alarm point. 

Click Acknowledge button in the acknowledge column for a pop-up dialog for 

acknowledgement of fault. (Requires login on User level 2 or 3.) 

The pop-up dialog for acknowledgement of fault gives two choices for fault 

acknowledgement, either acknowledge the current fault or acknowledge all faults in the 

fault list. 

4.4.4 Disablement 

In case of disablement, click on the disablement icon  or List button  to view the 

corresponding disablement list. This list is separated into tab pages for respective 

disablement type.  

Click Re-enable button in the re-enable column for a pop-up dialog for re-enabling the 

disablement. (Requires login on User level 2 or 3.) 

4.4.4.1 Zone or Zone-Address Disablement 

The Time (date & time), Zone, Address, Re-enable time and Reason (e.g. via the 

menu) is displayed. 

Link1 and Link2 = A hyperlink to open a web-camera, document, a drawing etc. for more 

information regarding the alarm point. 

4.4.4.2 Output Disablement 

The Time (date & time), Control unit, Expansion Board, Loop, and Address is 

displayed. 

Output type = The type of output, such as, Control, Ventilation, Extinguisher, Alarm 

devices, ATR, Neutral, or FTR.  

Output = The output number. 

Reason = e.g. via the menu. 

4.4.4.3 Output type Disablement 

The Time (date & time), and Control unit, is displayed. 

Output type = The type of output, such as, Control, Ventilation, Extinguisher, Alarm 

devices, ATR, Neutral, or FTR.  

Reason = e.g. via the menu. 
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4.4.4.4 Interlocking (output) Disablement 

The Time (date & time), Area, Point and Text (interlocking text) are displayed. 

4.4.4.5 COM-loop/Input Disablement 

The Time (date & time), Control unit, Expansion Board, Technical No., and Loop 

(Input) is displayed. 

4.4.4.6 Other (Alert annunciation) Disablement 

The Time (date & time) and Text (disablement text) are displayed. 

This list is only showing Alert annunciation disablement. 

4.4.5 Technical Warning 

In case of technical warning, click on the technical warning icon  or List button  to 

view the technical warning list. 

The Time (date & time) and Text (technical warning text) are displayed. 

4.4.6 Interlocking 

In case of interlocking input/output activations, click on the interlocking icon  or List 

button  to view the interlocking list. 

The Time (date and time), Area, Point and Text (interlocking text) are displayed. 

Input = Input is activated. 

In.Act.Time = The input activation time. 

Output = Output is activated. 

Out.Act.Time = The Output activation time. 

Click Reset button in the reset column for a pop-up dialog for reset of activated interlocking 

output. (Requires login on User level 2 or 3.) 

4.4.7 Door Open 

In case of open doors, click the List button  to view the door list. 

The Time (date & time) and Control unit are displayed. 

FBP = The number of the Fire Brigade Panel, in case of door opened at FBP. 

4.4.8 Zones in Test Mode 

In case of zones in test mode, click the List button  to view the list of zones in test mode. 

The Time (date & time) and Zone are displayed. 

Click De-activate button in the de-activate column for a pop-up dialog for de-activation of 

the zone in test. (Requires login on User level 2 or 3.) 
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4.4.9 Service Signal 

In case of detectors having activated service signal, click the List button  to view the 

service signal list. 

The Time (date and time), Zone, Address, Technical No and Text (alarm text) are 

displayed. 

Link1 and Link2 = A hyperlink to open a web-camera, document, a drawing etc. for more 

information regarding the alarm point. 

Click Acknowledge button in the acknowledge column for a pop-up dialog for 

acknowledgement of service signal. (Requires login on User level 3.) 

4.4.10 Output Activation 

In case of forced output activations, click the List button  to view the output activation 

list. 

The Time (date & time), Control unit, Expansion Board, Loop, and Address is displayed. 

Output = The output number. 

Click De-activate button in the de-activate column for a pop-up dialog for de-activation of 

the force activated output. (Requires login on User level 2 or 3.) 

4.4.11 WEB Function Disablement (WEB Status) 

In case of any WEB-function disablement, click the WEB function icon  or the List button 

 to view the WEB function disablement list. 

This view shows the current status of disablement of WEB functions, such as emails, PC-

buzzer, and Gateway. It also shows the time-stamp for previous login and current EBLWeb 

software version. 

4.4.12 Communication Error 

In case of any communication error, click on the communication error icon  or the List 

button  to view the communication error list. 

This view shows the current communication state for several kinds of communication errors 

as listed. If in error state, the state will be ‘blinking’ Error, otherwise a steady Normal will 

be shown. 

EBL - WEB 
Communication between 
CU and WEB-server. 

Could be disconnection error 
in serial cable. 

WEB - Browser 
Communication between 
WEB-server and browser 

Normally no TCP/IP 
connection with WEB-server 
from browser. 

E-mail SMTP - WEB 
Communication between 
SMTP-server and WEB-
server 

Normally no access to SMTP 
server. No e-mail can be 
sent. 

WEB - Gateway 

Communication between 
WEB-server and current 
configured Gateway 
function. 

Normally no replies/ACK 
from the gateway device. 
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4.5 Event Log 

Click event log button    to show the Event log view. 

The event log of EBLWeb consists of five types of logs, where three of them are the same 

as in the control unit, namely, Alarm log, Interlocking log and General event log.  All logs in 

EBLWeb are circular logs. The events in a Firetracker system are stored in both the 

FT1020G3 / FT128 CIE and in the Web-server.17 

The Time (date & time), and Event (event text) is displayed. 

Description = Additional information of the event when applicable. 

User = The user that performed that specific event. 

Origin = The source where the event originated from. 

 

4.5.1 All Log 

The all log is a special log in EBLWeb that collect all events in the same log with a capacity 

of 9999 log events. 

4.5.2 Alarm Log 

This log contains all alarm related events. This log shall show the same events as the CU 

alarm log with a capacity of 999 log events. 

4.5.3 Interlocking Log 

This log contains all interlocking related events. This log shall show the same events as the 

CU interlocking log with a capacity of 999 log events. 

4.5.4 General Log 

This log contains all general events. This log shall show the same events as the CU general 

log with a capacity of 999 log events. 

4.5.5 WEB Log 

This log contains all web related events, with a capacity of 999 log events. 

4.5.6 Test Mode Alarm 

This is a log to keep track of the test mode alarms. The test mode alarms normally reverts 

back to normal after 10 seconds. This test mode alarm log is used to record the test mode 

alarms in a list. In this, there’s a sub-menu to send this list of test mode alarms to a pre-

defined e-mail recipient and also clear the list from all recorded test mode alarms. 

4.6 Maintenance (WEB Function) 

Click Maintenance button  to show the Maintenance view.  

This view contains two tab pages, one for WEB functions and the other for Web links. 

                                                             

17
 If the Web-server is disconnected, the events during that time will not be saved in the Web-server, i.e. not shown in the event 

log.  When you restart the Web-server, the event log will be erased. 
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4.6.1 Web Function 

The tab page shows WEB function disablement page with operations to Enable or Disable 

the WEB function. Each function is Enabled or Disabled by a selection of the 

corresponding radio button. Click Apply to perform the action. 

4.6.1.1 All e-mail Function 

This disablement is to stop all kinds of e-mail sending from EBLWeb. 

 

4.6.1.2 E-mail Function 

This disablement is related to each type of e-mail, i.e. Fire alarm / Pre-warning, 

Disablement, Interlocking, Fault, Service, Test mode alarm and Technical warning.  

 

4.6.1.3 PC Buzzer Function 

This disablement is related to the PC-buzzer that which sound for each new fire alarm or 

control unit communication fault. 

There is also a button for test of the PC-buzzer (four long beeps). 

4.6.1.4 Gateway Function 

This disablement will stop the Web-server to send messages to the current configured 

gateway, such as Tateco, EBLTalk, or SIA. 
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4.6.1.5 FTP Function 

This disablement will stop the FTP access to the Web-server. 

4.6.1.6 TELNET Function 

This disablement will stop the TELNET access to the Web-server. 

4.6.2 Web Link 

Web links are URLs used for additional documents or web-cameras for a defined zone-

address/detector. This tab page will show a list of all web links currently configured via 

EBLWin.  

 

4.7 Basic Information 

Click the basic information button  to show the basic information view.  

This view has a tab page that shows the user information for the curren logged in 

user and another tab page for the e-mail address configuration for each e-mail 

type. 

4.7.1 (Username/Password) 

Click the basic information button  then the select button  to change the user 

login password. The password change requires a current password in order to set a new 

password. Once applying the password change, the new password will be changed for the 

Firetracker system as well.  

 

4.7.2 E-mail Address 

The e-mail handling in EBLWeb handles six different types of e-mails. Each e-mail type can 

be disabled. See E-mail Function in section 4.6.1.2.  The EBLWin configured e-mail 

addresses for recipients are shown in this tab page. Each e-mail address shown has a 

button to send a test mail to the configured e-mail address. 
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4.8 Control Unit 

Click the control unit button  to access the control unit list view. 

This page shows all control units in the Firetracker system. Each control unit row has a 

colour sign for synchronisation status.  

■ BLACK  Not connected. 

■ RED  Synchronisation has not started. 

■ YELLOW Synchronisation is in progress. 

■ GREEN Synchronisation is finished. 

 

Control units to be monitored and included for synchronisation are determined by the SSD 
from EBLWin. Those control units that are included according to SSD, will have buttons for 
Control unit statistics (Sys.info.) and Loop statistics. 

 

4.8.1 Control Unit Statistics (System Information) 

This page shows the system information of the selected CU and consists of momentary 

statistics data requested from the connected CU.  

The current consumption for power supply, current consumption for charger, battery 

temperature, low capacity voltage difference, site name (also time of SSD download) and 

software version for the CU is displayed. 

4.8.2 Loop Statistics 

This page shows the COM loop statistics for communication in selected CU. 

 

4.9 Detector Diagnostics 

Click the detector diagnostics button to access the detector diagnostic page.  

This page shows two kinds of lists to display detector information.   
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4.9.1 Detector List 

This page requests the sensor values from the control unit. When selecting Detector list, 

it will first give an input window. Specify from which technical number the sensor list should 

start requesting sensor values from the control units.  Example detector lists: 

 

4.9.2 Service List 

This page will list all detectors that have activated service signal.  See Service Signal in 

section 4.4.9 
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5 Remote Operations 

Note: Although the Web-server II is capable of controlling the panel remotely, this is 
prohibited in some state regulations.  Please check with your state regulations if this is 
permissible. 

To access remote operation in EBLWeb, click the remote operation button   . 
 
It will expand the submenu for different remote operations, which consists of four main 
types: 

 Disablement 

 Activation 

 Test 

 Maintenance 
 
The remote operations are user dependent, which means some menus or operations will 
be hidden from users with insufficient user level. 
 
Most of the remote operations provide feedback functions to check if the operation was 
executed successfully, partially successful, or not executed. However, some operations 
don’t give any feedback, i.e. “one-shot operations”. 
 

Operation succeeded 
 

Operation partly succeeded 
 

Operation failed 
 

 

5.1 Disablement Operations  

Click the disablement operations button   to access a list of different disablement 
operations. 
 

 
 
A click on the select button on each item will give the user a sub menu with choices of 
specific type for the corresponding disablement or a pop-up window with operations to 
Disable or Re-enable the disablement.  

The back-button returns to the previous menu by one level. 
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5.1.1 Zone  

A specified Zone can be disabled / re-enabled and an automatic re-enable time can be set. 
 

 
 

5.1.2 Zone-Address  

A specified alarm point (Zone-Address) can be disabled / re-enabled and an automatic re-
enable time can be set. 

5.1.3 Output  

A sub menu for several types of outputs: 
 

 
 

5.1.3.1 Loop Unit Output  

A specified loop unit (tech.no.), output (0-2) can be disabled / re-enabled.  

Note: In system FT128 the tech.no. is “000” plus the COM loop address, e.g. 000123.  

5.1.3.2 Voltage Output (S)  

A specified voltage output (0-3) in a specified control unit (00-29) can be disabled / re-
enabled.  

5.1.3.3 Relay Output (R)  

A specified relay output (0-1) in a specified control unit (00-29) can be disabled / re-enabled.  

5.1.3.4 Expansion Board Output  

A specified output (0-7) on a specified 4581/4583 expansion board (0-5), in a specified 
control unit (00-29), can be disabled / re-enabled.  

Note: 4583 has three outputs (0-2).  

5.1.3.5 Interlocking Output  

An interlocking can be disabled / re-enabled via a specified interlocking combination Area-
Point.  
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5.1.4 Output type  

A sub menu for several types of outputs. All outputs of the type respectively will be 
collectively disabled / re-enabled.  

5.1.4.1 Control Output  

All outputs of type "control", can be collectively disabled / re-enabled (all at the same time) 
in all control units or in a specified Control Unit (00-29).  

5.1.4.2 Ventilation Output  

All outputs of type "ventilation", can be collectively disabled / re-enabled (all at the same 
time) in all control units or in a specified Control Unit (00-29). 

5.1.4.3 Extinguishing Output  

All outputs of type "extinguishing", can be collectively disabled / re-enabled (all at the same 
time) in all control units or in a specified Control Unit (00-29).  

5.1.4.4 Interlocking Output  

All outputs of type "interlocking", can be collectively disabled / re-enabled (all at the same 
time) in all control units or in a specified Control Unit (00-29).  

5.1.5 Alarm Devices  

All outputs of type "alarm devices", can be collectively disabled / re-enabled (all at the same 
time) in all control units.  

5.1.6 Routing Equipment  

A submenu with Fire routing equipment and Fault routing equipment.  

5.1.6.1 Fire Routing Equipment  

The FIRE output for routing equipment (Fire Brigade TX) can be disabled / re-enabled.  

5.1.6.2 Fault Routing Equipment  

The FAULT output for routing equipment (Fault TX) can be disabled / re-enabled.  

5.1.7 Alert annunciation  

The Alert Annunciation function can be disabled / re-enabled.  

Note: This operation has higher priority than any time channel controlling this function.  

5.1.8 COM-Loop / Zone Line Input  

A sub menu with the three types that can be disabled.  

5.1.8.1 COM-Loop  

A specified COM Loop (0-3) in a specified Control Unit (00-29) can be disabled / re-
enabled.  

5.1.8.2 Zone Line Input  

A specified zone line input (0-7) on a specified 8 zones expansion Board (0-5), in a specified 
Control Unit (00-29), can be disabled / re-enabled. 

5.1.8.3 Zone Interface  

The zone line input (0) on a specified COM loop unit (3361) / technical number (Tech. No.), 
can be disabled / re-enabled.  

Note: In system FT128 the tech.no. is “000” plus the COM loop address, e.g. 000123. 
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5.2 Activation Operations  

Click the activation operations button to access a list of different activation 
operations. 
 

 
  

A click on the select button on each item will give the user a sub menu with the different 
output types or a pop-up window with buttons to Activate or De-activate.  

The back-button  returns to the previous menu by one level. 
 

5.2.1 Output  

A sub menu for several types of outputs.  

5.2.1.1 Loop Unit Output  

A specified loop unit (Tech. No.), Output (0-2) can be activated / de-activated.  

Note: In system FT128 the tech.no. is “000” plus the COM loop address, e.g. 000123.  

5.2.1.2 Voltage Output (S)  

A specified voltage Output (0-3) in a specified Control Unit (00-29) can be activated / de-
activated.  

5.2.1.3 Relay Output (R)  

A specified relay Output (0-1) in a specified Control Unit (00-29) can be activated / de-
activated.  

5.2.1.4 Expansion Board Output  

A specified output (0-7) on a specified 4581/4583 expansion board (0-5), in a specified 
Control Unit (00-29), can be activated / de-activated.  

Note: 4583 has three outputs (0-2).  

5.2.1.5 Interlocking Output  

An interlocking output can be activated / de-activated via a specified interlocking 
combination Area-Point. 

5.3 Test Operations  

Click the test operations button to access a list of different test operations. 
 

 
 
A click on the select button on each item will open a pop-up window with operations to 
Activate or De-activate the Zone test or Alarm devices test.  



Operation & Installation Manual  
      MA440 Rev 1.0 

 

 

44 of 62 
 

5.3.1 Zone Test  

A specified zone (0-999) can be set in test mode, i.e. test mode activated / de-activated.  
Zones in test mode can also be de-activated from the Zones in test mode list. See 4.4.8 
page 33.  

5.3.2 Alarm Devices  

All outputs of type "alarm device" can be collectively activated / de-activated for test. All at 
the same time in all control units or in a specified Control Unit (00-29).  

5.4 Maintenance Operations  

Click the maintenance operations button to access a list of different maintenance 
operations. 
 

 
 
A click on the select button on each item will open a pop-up window with corresponding 
maintenance operation.  

5.4.1 Set Calendar and Time  

The date and time for the Web-server and the Firetracker system can be set in the pop-up 
dialog box. Click apply to set the date and time currently shown in the dialog box or click 
cancel for no change. 

5.4.2 Synchronise  

This operation starts a synchronisation of the Firetracker system, which includes FT1020G3 
/ Ft128 CU, EBLWin, and EBLWeb. The synchronisation status of each Control unit is 
shown in the Control unit list. See section 4.8 page 38.  

5.4.3 Silence Alarm Devices  

This operation works like the Silence Alarm Devices button on the Control Unit front.  

Note: Cannot be activated if there is no fire alarm in the system.  

5.4.4 Evacuate  

This operation activates / de-activates the evacuate function.  

5.4.5 Sensitive Fault Detection Mode  

This operation activate / de-activate the Firetracker system for sensitive fault detection 
mode.  
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5.4.6 Calibrate Outputs  

This operation starts a calibration of all supervised outputs in the Firetracker system.  

5.4.7 Close Fire Doors  

This operation will collectively close all fire doors, i.e. programmable outputs with a control 
expression containing one or more trigger conditions Fire Door Closing (zone – address), 
in all control units or in a specified Control Unit (00-29).  

5.4.8 Fire Drill Mode  

Fire drill mode activated will disable all outputs except outputs of type Control neutral and 
type Alarm devices.  
 

 
 
An alarm point activating fire alarm will now activate all alarm devices, in order to evacuate 
the building (a fire drill). 
 

Important: The system will remain disabled until de-activated. Remember to de-
activate after the fire drill. Choose “De-activate” to enable the system back to normal 
conditions. 
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6 Configuration of EBLWeb  

The EBLWeb is configured via the PC tool EBLWin 2.1.0 or later. The EBLWeb software, 
the configuration data and the site specific data (SSD) will be downloaded to the Web-
server via TCP/IP18. See EBLWin, menu Tools.  
 
All the EBLWeb related menu options and dialog boxes in EBLWin are described in the 
following chapters.  

6.1 Web-server  

To configure a Web-server for the Firetracker system, a Web-server must be added to a 
Control Unit (Control unit pop-up menu, Add Web-server). Up to 5 Web-servers may be 
added to the Firetracker system, with a limit of 1 Web-server per Control Unit.  
 
Once added, a properties dialog box for the Web-server will be opened. More about each 
setting is described below. The properties dialog box can always be accessed by right-
clicking on the Web-server in the EBLWin tree view, and select properties.  

6.1.1 General Information  

Since there is a limitation of the maximum numbers of Web-servers for a Firetracker 
system, each Web-server must have a unique technical address (0-4). A default Web-
server Name is shown. The Web-server name is shown in the tree view of EBLWin.  

6.1.2 Unit Information  

To be able to download a specific configuration to a specific Web-server, the Hardware ID 
(normally five characters) is required to identify the web server unit. This ID is printed on 
the side of the Web-server plastic enclosure e.g. ID:1BADB. 
 

6.1.3 Unit Settings  

6.1.3.1 IP Address Settings  

Use DHCP: Select this option when a dynamic IP number is to be used (instead of a static, 
see below).  
 
Device name: It is always recommended to have a Device name, not only when a dynamic 
IP number is used.  
 
If a static IP number is to be used, the following data have to be specified:  

 IP address (for Web-server)19  

 Netmask20  

 Gateway20  

6.1.3.2 DNS Settings 

Use DNS: Select this option when Domain Name Server is to be used. DNS is used to 
translate name address into IP address. 
 
Primary DNS: The IP address to the primary DNS20. 
 

                                                             

18 The Web-server 1598 and the PC both have to be connected to the Local Area Network (LAN). As an alternative a "Crossed 
network cable" or a Hub can be used. 
19 The IP address is set to 192.168.1.169 on delivery. If the Local Area Network (LAN) administrator demands another IP 

address to be used, it can be changed via the PC tool CHIPTOOL provided free of charge by BECK IPC website: 
http://www.beck-ipc.com   
20 Provided by LAN administrator.   



Operation & Installation Manual  
      MA440 Rev 1.0 

 

 

47 of 62 
 

Secondary DNS: The IP address to the secondary DNS20. 

6.1.3.3 NTP Settings 

Normally the Control Unit no. 00 in an FT1020G3 system will send out the date & time at 
midnight every day, to synchronise the clock in all Control Units in the system as well as 
the clock in Web-server II. 
 
For continuous correct time and synchronisation of all the clocks an NTP21 server can be 
used. In this case, synchronisation will be done one hour after midnight every day. 
 
NTP server: The NTP server's IP address. If DNS is selected (see above) the server name 
is used instead. 

6.1.3.4 Event Log 

All the events in the Firetracker system will also be stored in the Web-server internal RAM. 
In the case of a power loss (or unexpected reboot), the event log will be lost. 
 
Daily log save: The event log will be automatically saved to flash memory once every day 
(one hour after midnight). 

6.1.3.5 FTP/Telnet Access 

When the Web-server shall be configured (programmed) via the PC tool, this will be done 
via FTP/Telnet via a LAN network (or crossed Ethernet cable or a hub). For safety reasons, 
Username and Password are used for FTP/Telnet. The default username/password are 
ftp/ftp, but this can be changed. 
 
New username: Type the new username. 
 
New password: Type the new password. (Only dots will be dis-played.) 
 
Confirm password: Re-type the new password once more. (Only dots will be displayed.) 
 

Note: The new Username and Password will not be valid until after download and 
restart of the Web-server. 

6.1.4 Browser Settings  

Settings in this tab page are related to how the web browser access and displays the web 
pages. 
 

                                                             

21 NTP (Network Time Server) is a protocol designed to synchronise the clocks of computers over a network.   
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6.1.4.1 Project Name / Custom Text  

Project name and custom text are shown in the upper-right corner of the web pages.  
 
Project name: a row of text that can be used to identify which Firetracker system this web 
server belongs to.  
 
Custom text: Three rows of text for some additional information that can be shown, e.g. 
contact information.  

6.1.4.2 Custom Logo  

The custom logo will be shown in the lower-right corner of the web pages.  
Browse: Opens a dialog to select an appropriate image (jpg, gif, bmp) used for logo. 
Recommended format size of image is 210x56 pixels.  
If no custom logo is selected, the Panasonic logo will be used. 

6.1.4.3 Web Link  

If an alarm point is presented, it is possible to click the hyperlink for e.g. a document or a 
camera to get more information about the alarm point. Up to 500 links can be used.  
Web links settings. 
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The web links are based on three levels: 
  

 Level 1 is used to configure two links for all alarm points in the system. The links 
configured here will fully cover zone-addresses from 001-01 to 999-99.  

 Level 2 is used to configure two links for specific zones in the system. One zone 
per row. The links configured here will cover a full zone from ZZZ-01 to ZZZ-99, 
where ZZZ can be any zone from 001-999.  

 Level 3 is used to configure two links for specific alarm points in the system. One 
alarm point per row. The links configured here will cover one zone-address, 001-
01 to 999-99 can be used.  

 

6.1.4.4 Browser Access  

The web pages are by default configured to be accessed without encryption with http, but 
if more safety for access is needed, https access with encrypted communication via SSL 
can be used. (See below.)  
 
Browser URL: Type the web-address (URL) for accessing this Web-server. This will be 
used as Web-server URL in e-mails, if used.  

 http://x  

 https://x  

 http/https://x  
 
x = IP-address or the Device name.  

6.1.4.5 SSL Certificate  

If https is going to be used for webpage access, the SSL certificates needs to be defined. 
 
There are two ways to define SSL certificates in the configuration. Either self-issued 
certificate or vendor-issued certificate can be used.  

6.1.4.5.1 Self-Issued  

It is possible to create certificates in the configuration tool in EBLWin, but the certificate 
created using Open SSL is not verified by any trusted certificate authority, thus a warning 
might be shown in the web browser. 
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Click the Create button to open dialog to create certificate.  
 
Once created the create button will change to completed to show that the certificate has 
already been created.  
 
The Retrieve button is used to retrieve and save the current certificate (CACERT.crt) in 
some other place in the computer (PC).  

6.1.4.5.2 Vendor Issued  

If the certificates are vendor-issued, it can be configured to the EBLWeb with this option.  
 
CA certificate: Type the path and file name (e.g. intermed.pem) or use the Browse button.  
 
Private key: Type the path and file name (e.g. privkey.pem) or use the Browse button.  
 
Server certificate: Type the path and file name (e.g. cert.pem) or use the Browse button. 

6.1.5 Gateway / EBLNet Settings  

The EBLWeb is not only a Web-server but can also be a gateway to another system.  
One of the following gateway types can be selected:  
 

 None: No gateway function will be used.  

 Tateco: Used when fire alarm information is to be transmitted to and presented in 
an Ascom Tateco paging system.  

 EBLTalk: Used when fire alarm information is required to be transmitted to and 
presented in a separate PC system, via RS232 or via TCP/IP. EBL Talk is an open 
protocol. For more information see "EBL Talk Protocol" Technical Description 
(MEW00532).  

 SIA: Used when fire alarm information is to be transmitted to and presented in a 
separate PC system, via the SIA protocol.  

 MODBUS: Used when fire information is to be transmitted via MODBUS protocol. 
Only occurrence of fire alarm per zone is registered.  

6.1.5.1 COM Port Settings  

COM port settings are used for the serial communication (RS232) set-up used with EBLTalk 
or Tateco protocols.  
 
Normally defaults settings are used for EBLTalk or Tateco, but it’s possible to change to 
suitable settings depending on corresponding client communication settings.  
Click Reset defaults button to restore the defaults settings for COM port.  

6.1.5.2 EBLTalk Settings  

EBLTalk can be used via COM-port (RS232) or via Ethernet TCP/IP port.  

6.1.5.3 SIA Settings  

Client IP (MAS) address and Sender ID are required. (Provided via the Local Area Network 
(LAN) administrator and/or SIA administrator.)  

6.1.5.4 Tateco Settings  

Tateco uses a COM-port and need a Tateco file to be defined. A tateco file has to either be 
created (Create) or an existing file has been selected (Browse).  

6.1.5.5 MODBus Settings  

MODBUS uses a COM-port and only 8 bits data with 1 stop bit is supported. A slave ID 
needs to be defined which is used by a Modbus software to retrieve data. 
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6.1.5.6 EBLnet Settings 

EBLnet is used to connect the Firetracker system to a Security Management system. 
 
EBLnet licence 5097 is a kit containing: 
 

 EBLnet licence number (key) document 

 EBLnet licence number label 

 User instructions 
 
EBLnet active:  Has to be selected to activate the EBLnet function. This has to be done 
before the Web-server can be connected to the Security Management system.  See Walk-
Thru Guide Section 3.2 step 21). 
 

Note: The EBLnet key is a 40 character key purchased from Brooks. The Web-server 
ID must be provided in order to receive the key (licence). 

 
Port number: A port must be set. Provided via the Local Area Network (LAN) administrator.  
See Walk-Thru Guide in section 3.2 step 21).  
 

NOTE!  Port 80 is used by the Web-server and cannot be used elsewhere. 

 

6.1.6 Notification Settings  

The Web-server can be configured to send e-mails if certain types of events occur. Six 
different types of e-mails, based on the type of events, can be sent. 
 

 

Tip: If you only have the SMTP address in pain text format, go to windows command 
prompt and ping it, example: ping panasonic.com. This will convert your plain text 
format into dotted decimal format. 
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6.1.6.1 SMTP Server 

IP address / Server name: Type in the IP address for a SMTP server or type in the SMTP 

server name if DNS is used. 

Port number: Type in the port number for SMTP server, the default port is 25. 

Sender address: The address that will be shown as sender in e-mails sent from the 

Web-server. 

 Unchecked checkbox: default sender address “EBLWebMail” will be used. 

 Checked checkbox: Write the required sender address. 

Note: The default sender address might not work for some SMTP servers that require 
a valid sender address. 

6.1.6.2 SMTP Authentication 

Used if SMTP server requires authentication before sending e-mail. 

Username: Username for the SMTP server. 

Password: Password for SMTP server. 

Note:  EBLWeb only supports authentication using PLAIN, LOGIN or CRAM_MD5.   

6.1.6.3 E-mail 

Click on the E-mail settings button to open a dialog for configuration of each e-mail type. 

Up to five e-mail addresses can be configured for each type of e-mail and each e-mail 

address can be send as To, CC, or BCC address. 
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Click on Compose button for respective e-mail type to open a compose dialog box. 

Subject: An e-mail "Subject" text should be written, e.g. "Fire alarm".  The "Subject" text 

will be shown in the receivers e-mail Inbox list view, together with the name of the e-mail 

sender, date and size. 

Body: An e-mail "Body" text should be written.  Up to 500 characters can be used, including 

some parameters (see below).    
The parameters in the receiver's e-mail will be replaced with the information they represent. 

 

Refer to steps 22) & 24) under Section 3.2 Walk-Thru Guide for set up example. 

6.1.6.3.1 Fire Alarm / Pre-Warning e-mail 

The following parameters can be used together with any other text in the subject and body 

text. 

{Project name}: The custom name of the project which is configured in the Browser 

settings. See  

{Date time}: Date and time for occurrence of an event. 

{Event type}: Type of alarm, i.e. pre-warning, heavy smoke etc. 

{De-activate state}: Show if the alarm goes back to normal state for pre-warning or the 

alarm point is reset. 

{Presentation information}: The presentation number i.e. Zone-address. 

{Text message}: The user definable alarm text shown in the fire alarm system CIE 

displays, for the alarm point respectively. 

{Web link URL}: The links associated with an alarm-point.  
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{Browser URL}: The URL to access the Web-server. 

6.1.6.3.2 Disablement e-mail 

The following parameters can be used in the subject and body text. 

{Project name}: The custom name of the project which is configured in Browser settings.  

{Date time}: Date and time for occurrence of an event. 

{De-activate state}: Show if the disablement is re-enabled. 

{Text message}: The disablement text shown in the fire alarm system CIE displays. 

{Web link URL}: The links associated with an alarm-point.  

{Browser URL}: The URL to access the Web-server. 

6.1.6.3.3 Interlocking e-mail 

{Project name}: The custom name of the project which is configured in Browser settings.  

{Date time}: Date and time for occurrence of an event. 

{Event type}: Type of activation, i.e. INPUT, OUTPUT, or INPUT/OUTPUT activation. 

{De-activate state}: De-activation of interlocking. 

{Presentation information}: The presentation number i.e. Area-Point. 

{Text message}: The user definable interlocking text shown in the fire alarm system CIE 

displays. 

{Browser URL}: The URL to access the Web-server. 

6.1.6.3.4 Fault e-mail 

{Project name}: The custom name of the project which is configured in Browser settings.  

{Date time}: Date and time for occurrence of an event. 

{De-activate state}: Show if fault is serviced. 

{Presentation information}: The presentation number i.e. Technical number or/and 

Zone-address. 

{Text message}: The fault text shown in the fire alarm system CIE displays, for the fault 

respectively. 

{Web link URL}: The links associated with an alarm-point. 

{Browser URL}: The URL to access the Web-server. 

6.1.6.3.5 Service / Contamination e-mail 

{Project name}: The custom name of the project which is configured in Browser settings.  

{Date time}: Date and time for occurrence an event. 

{De-activate state}: Show if service signal is acknowledged. 
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{Presentation information}: The presentation number i.e. Zone-address. 

{Web link URL}: The links associated with an alarm-point.  

{Browser URL}: The URL to access the Web-server. 

6.1.6.3.6 Test Mode e-mail 

{Project name}: The custom name of the project which is configured in Browser settings.  

{Browser URL}: The URL to access the Web-server. 

Note: The body text will automatically also show a list of the tested alarm points. 

 

6.1.6.3.7 Technical Warning e-mail  

{Project name}: The custom name of the project which is configured in Browser settings. 

See 6.1.2.1.  

{Date time}: Date and time for occurrence of an event.  

{De-activate state}: Show if technical warning is serviced.  

{Text message}: The technical warning text shown in the fire alarm system CIE displays, 

for the technical warning respectively.  

{Browser URL}: The URL to access the Web-server. 
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7 Software and Configuration 

The EBLWeb mainly consists of two parts that need to be downloaded into Web-server II 

1598, to be fully functional. 

 The software package (EBLWeb210.BIN) 

 The Web-server configuration data and the Firetracker system SSD. 

7.1 EBLWeb Software Package 

The software package consists of all necessary files and configurations to make EBLWeb 

function as default, without any specific configuration. The specific language of preference 

is included in this package. 

7.1.1 Download 

1. Click Download EBLWeb software from the Tools menu of EBLWin 2.1.x.  
      

All available Web-servers must be configured with an IP address.  If the IP address 
does not show up automatically, it might mean that it was not configured correctly.   In 
this case, try these steps in this order: 
 

A) Right click on the Web-server and 
choose “Download EBL Web 
configuration” from the context menu.  
This checks for the existing Web-
server configuration if any was set.  

B) Return to Download EBLWeb software and click  to look for all 
available Web-servers in the current network, and select the corresponding IP 
address for the software download. If the IP address was not listed, either 
repeat or check through the procedures under Quick Start in Section 3 from 
steps 11) to 15).   

 

2. Once the IP address is displayed, click  to locate the software package 
(EBLWeb210.BIN) that should be downloaded. 

 

3. Then click , an FTP window will open asking for User and Password.  By 
default, it is: 

 

Username:  ftp 
Password:  ftp 

 
Once the download is completed, a restart is required before the new software takes effect.  
This should take no more than 90 seconds.  A pop-up dialog will ask if the user wants to 
download configuration data before doing a restart. Once restarted the Web-server will 
work as default without any specific configuration i.e. any previous IP addresses, Gateway, 
and Netmask set will return to default values.   Follow steps 11)-15) under Section 3.2 page 
11 to reconfigure. 
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7.2 EBLWeb Configuration Data 

The configuration data consists of the specific settings that are made via the Web-server 

properties. When the configuration data is downloaded, it will also include a backup of the 

configuration that can be retrieved with via upload.  

7.2.1 Download 

Click Download EBLWeb configuration from the Tools menu of EBLWin. 

The Web-server list in the top only shows all Web-servers that are configured with a valid 

hardware ID and connected to the LAN. Select a Web-server for download of configuration 

data. 

 

7.2.2 Backup (Upload) 

Backup of configuration data can be performed by clicking on Backup EBLWeb 

configuration in Tools menu. 

The backup dialog is similar to the download dialog. It requires an added Web-server in 

tree view with a valid hardware ID that would be shown in the Web-server list. This is where 

the backup configuration be stored once uploaded. 

For more than 1 Web-servers in the network, remember to click first before clicking 

on .  The Web-server should be listed and selected before clicking on . 
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7.3 Site Specific Data (SSD)  

Site Specific Data (SSD) is user configurable data from the EBLWin that is used in the 

Firetracker system including all control units. This data includes specific data such as, user 

data and alarm points in the system, etc. This SSD needs to be downloaded into the Web-

server as well, since the EBLWeb needs the user data for its user handling system, and 

also for keeping track of how many control units the Firetracker system consists of. 

The download of SSD data can be done in three ways. 

 Via download of configuration data. 

 Via download of SSD for control units. 

 Via individually download for each Web-server. 

7.3.1 Download via Configuration Data 

This is done by checking the box Include SSD Data via the download of EBLWeb 

configuration dialog. 

7.3.2 Download via Download SSD for Control Units 

When downloading SSD for control units in EBLWin, there is a choice to Download Web-

server SSD in the dialog box. This command is selected from the EBLWin menu 

Tools>Download SSD22.  If the checkbox for  is ticked, the SSD will be 

downloaded for each connected Web-server in each control unit. 

 

Note: EBLWin has to be logged on to the Firetracker system. 

7.3.3 Download via Individual Menu 

The SSD can be specifically downloaded to each Web-server by right-clicking in 

respective Web-server and select Download SSD… in the context menu. 

 

Note: EBLWin has to be logged in on the Firetracker system. 

                                                             

22 Not to be confused with the context menu on the Web-server (right-click on Web-server) in the tree menu and selecting 

Download SSD.  This context menu will only download the Web-server’s SSD.  
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8 Installation / Commissioning 

Web-server II (1598) is used in the FT1020G3 system or FT128. It is intended for indoor 
use and in dry premises. 
 
The Web-server is mounted vertically on a 35 mm DIN rail inside the CIE. 
 

One 0.65mm2 RS232 cable with a 3 way Molex plug is 
supplied, to connect the Web-server II to the FT1020G3 
CIE main board “J7” or to FT128 main board “J5”. Refer 
to the block wiring diagrams in Figure 4 for CIE Main 
Board specific connections.  On the Web-server plug-in 
connector PLC COM (RS232C), there are screw 
terminals for the yellow, green and black wires. (Refer to 
Figure 2 page 10) 

 
 
One 0.65mm2 power supply cable is supplied.  Plug 
this connector with the black EMI filter (see Figure 3) 
into the Web-server II power supply header.  The 
stripped end of this power cable connects to the screw 
terminals on the FT1020G3 CIE main board or to 
FT128 main board connector “J4”.   For terminations, 
refer to the respective connection diagram in Section 
9. 
 
 
 
 

The 
Web-server II also has a RJ-45 connector 
for a standard Ethernet CAT.5 cable used 
for connection to the Internet / an intranet 
(LAN).  (This cable is not supplied.) 

 
The Web-server has a 9-Way male "D" 
connector MODEM COM. (RS232C) 
port.  This is used to connect from the 
Web-server II to a separate PC system, 
etc. e.g. when one of the gateway 
functions is used. (This cable is not 
supplied.)  
 
 

8.1 LED Indicators 

There are three LED indicators on the Web-server II: 
 

 POWER: Indicating that the power supply is connected and is working. 

 COM: Indicating: 

o Ethernet connection (continuously) 

o Ethernet data exchange (blinking) 

 COM: Not used.  

 

Figure 3 EMII Filter on Web-
server  power cable 
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9 Connection Diagrams 

 

Figure 4 1598 WEB-SERVER II installed to FT1020G3 
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Liability Disclaimer 
 

This product should be correctly configured and installed to suit the site specific application to ensure 

fire safety. 

Brooks shall under no circumstances be liable for any incidental or consequential damages arising from 

loss of property or other damages or losses owing to the failure of Brooks products beyond the cost of 

repair or replacement of any defective products.  

Brooks reserves the right to make product improvements and change product specifications at any time. While 
every precaution has been taken during the preparation of this manual to ensure the accuracy of its contents, 
Brooks assumes no responsibility for errors or omissions. 
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